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Welcome 

 Thank you for choosing a Copam cutter from US Cutter.  The Copam cutters provide a 

professional level, high quality cutting experience for a fraction of the cost of most cutters of this 

quality. This manual is here to help provide a starting point in the learning process of the Copam 

cutters or to vinyl cutting in general. Please read it thoroughly and follow the steps carefully to help 

insure a trouble free experience with your new machine. If you have any questions along the way, 

we have provided a few locations to go to get those questions answered. You can post on the US 

Cutter forums at forum.uscutter.com, submit a request for support on the support website at 

support.uscutter.com, or call customer service at 425-481-3555. We hope you enjoy your experience 

with your new cutter and the US Cutter family. 
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Cutter Parts 

Before you start cutting, you should familiarize yourself with the cutter and its basic parts and functions: 

Front View 

 

 

 

 

 

 

 

 

Control Panel Used to provide input directly to the cutter. Covered in detail in the 
“Control Panel” (page 7) section of this manual. 

Carriage Arm  Holds the Blade (or Pen) Carriage. Shown in detail on page 5. 

Pinch Rollers Holds the media tightly to the feed roller below. Shown in detail on page 
6. 

Feed Roller Guides Shows the location of each feed roller so that the pinch rollers can be 
properly positioned to make contact with the feed rollers.  

Feed Rollers  
(Not Pictured. Located below 
each Feed Roller Guide.) 

Positions the cutting material during operation. 

Right Side Cover Contains the Power Switch and the Parallel, Serial, USB and Power 
cable ports for the cutter. Shown in detail on page 5. 
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Detail of Carriage Arm 

 

 

 

 

Right Side View 

 

 

 

  

  

Blade/Pen Carriage 
Slot  

Holds the Blade or Pen 
Carriage in place. 

Locking Knob Allows access to the 
Blade/Pen Carriage Slots for 
exchanging/replacing 
Carriages.  

Parallel Cable Port* Used to connect a 
parallel cable from the 
cutter to a computer. 

Serial (COM) Cable 
Port* 

Used to connect a serial 
cable from the cutter to 
a computer. 

USB Cable Port* Used to connect a USB 
cable from the cutter to 
a computer. 

Power Cable Port Used to connect a 
power cable from the 
cutter to a wall outlet 
or surge protector. 

Power Switch Main power switch for 
turning the power of 
the cutter on(1) or 
off(0). 

*Only one of the connection cables should be used to 
connect the cutter to a computer.  
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Back View 

 

 

Pinch Rollers Holds the media tightly to the feed roller below. Back view shown in detail below. 

 

 

Detail of Pinch Roller (Back View) 

 

 

  

Tension Screw Adjusts the tension of how tightly 
the pinch roller is held to the feed 
roller below.  

 Release Lever Allows you to release Pinch Rollers 
(either so they can be moved from side 
to side or to allow media to be easily fed 
below them) by pulling up on the 
Release Levers.  
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Control Panel  

Measure Screen 

 

 

 

 

 

 

The Measure Screen is the first screen that you will see when starting up the cutter. Select your media 

type from the menu and then confirm your selection. The cutter will then measure your material and 

report the cuttable area (in millimeters) on the Paper Size Screen (Next). If „Scroll‟ is selected, only the width is 

measured. If „Sheet‟ is selected than both the width and length of the material will be measured.  

 

Paper Size Screen 

 

 

 

 

 

 

The Paper Size Screen will display after a measurement has been made from the Measure Screen. This will 

display the cuttable area that the machine has detected for your media (in millimeters). You can record the 

dimensions and use them as a reference on your cutting software to ensure that you are creating designs 

that will fit within the cuttable area of your material.  

Left/Right 
Buttons 

Selects between the „Scroll‟ and „Sheet‟ media types. If you are cutting from a single sheet 
of media, select „Sheet‟. If you are cutting from a roll of media, select „Scroll‟.  

Enter Button Confirms the selection between „Scroll‟ and „Sheet‟.    

All other buttons have no function on this screen. 

Enter Button Exits the Paper Size screen and continues to the Function Select Screen (Next).    

All other buttons have no function on this screen. 
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Function Select Screen 

 

 

 

 

 

 

The Function Select Screen is the main screen for the cutter. From this screen you can access the Measure 

and Setup Screens, make test cuts, make a repeat cut of the last cut made by the cutter, or adjust the origin 

of the of the next cut to be made.  

 

  

Measure 
Button 

Accesses the Measure Screen (page 7) where the material loaded in the cutter can be 
measured and the size of the cuttable area can be displayed.  

Test Button Cuts a small test pattern to demonstrate the current settings of the cutter and allow you 
to see if they are appropriate for your current material. After the test cut has been 
made, the cutter will display the Setup Screen (page 9) to allow the option of changing 
any settings. 

Setup Button Accesses the Setup Screen (page 9)  where the main settings of the cutter can be 
viewed/changed. 

Pause Button 
 

Has no function on this screen. 

Enter Button Has no function on this screen when used alone. Can be used with the right and left arrow 
keys to perform advanced functions (below).  

Enter Button 
+ 
Left  Arrow 
Button 

When the Enter Button is pressed simultaneously with the Left Arrow Button a detailed 
test cut is made. This detailed test cut can be used to test the current settings of the 
cutter when the small test pattern is not sufficient for testing and also for more advanced 
troubleshooting.  

Enter Button 
+ 
Right Arrow 
Button 

When the Enter Button is pressed simultaneously with the Right Arrow Button a repeat 
cut is made of the last cut that was sent to the cutter. This is a simple way to make 
duplicate cuts of the same design. The repeat cut function will only retain the last cut 
information until the cutter is powered off. When the cutter is powered off, the last cut information 
is removed from the cutter memory and the repeat cut function will not be available until a new cut 
has been made. 

Up/Down/ 
Left/Right 
Arrow 
Buttons 

Pressing any of the arrow buttons will access the Jog screen of the cutter (Page 10) 
where a new starting position can be entered for the next cut. 
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Setup Screen 

 

 

 

 

 

The Setup screen allows you to view/adjust the main settings for the cutter. You can adjust the speed at 

which the cutter moves while cutting, the amount of force used to make cuts, and the blade offset which 

compensates for slight variations in blade sizes. You can also make a test cut to see if any of the settings 

need to be changed, or to check if the changes you are making are improving cutter performance.  

Speed Setting: The Speed Setting will adjust the rate at which the cutter operates while cutting. On 

smaller or more detailed designs, the speed should lowered to increase the precision of the machine. On 

larger or less detailed designs, the speed can be raised to decrease cut time. 

Force Setting: The Force Setting will adjust the amount of pressure that the blade uses when cuts are 

being made by the machine. This setting should be used in conjunction with proper blade depth (page 16) 

to allow the blade to fully cut the material, but not cut through the protective backing material of your 

selected media. Your blade depth should be adjusted to approximately; 

 The height of your cuttable material + ½ of the height of the backing material.  

This will allow the blade to fully cut the material without fully penetrating the backing. Once you have 

blade depth properly adjusted, change the pressure setting until you are getting smooth cuts.  

Offset: The Offset Setting allows the cutter to adjust for slight variations in different blade sizes. If your 

cuts are not fully closing, or are overlapping, you can adjust the Offset Setting to correct it. Standards for 

blade offsets are often found on the packaging of, or in the instructions that come with, the blade.  

Left/Right 
Arrow Buttons 

Selects the setting to be changed. 

Up/Down 
Arrow Buttons 

Adjusts the parameters of the selected setting. 

Enter Button Accepts the changes made and returns to the Function Select Screen. If you accessed the 
Setup screen from the Pause Screen, the Enter button will return to the Pause Screen. 

Test Button 
 

Cuts a small test pattern to demonstrate the current settings of the cutter and allows 
you to see if they are appropriate for your current material. After the test cut has been 
made, the cutter will return to the Setup Screen and further changes can be made. If 
you cut a test shape after entering the Setup Screen from the Pause Screen, the current cut will be 
canceled before the test cut is made.  

All other buttons have no function on this screen. 
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Jog Screen 

 

 

 

 

 

 

The Jog Screen is where the cutter, and the material loaded in the cutter, can be moved to create a new 

starting location for the next cut to take place from. The X and Y values on this screen will show the 

amount of movement that has taken place in relation to the initial origin of the cutter. You will only be able 

to move the cutter within the cuttable area that has been determined when the material was measured by the cutter.   

Left/Right 
Arrow Buttons 

Moves the Carriage Arm from side to side.   

Up/Down 
Arrow Buttons 

Moves the material forwards and backwards.  

Enter Button 
(pressed) 

Pressing the Enter Button will return to the Function Select Screen but will not reset 
the origin of the cutter or material. To reset the origin you must hold the Enter Button for 2 
seconds (below). 

Enter Button 
(held down) 

Holding the Enter Button for 2 seconds will reset the origin of the cutter. The next 
cut that takes place will be made from this new origin location.  

All other buttons have no function on this screen. 
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Pause Screen 

 

 

 

 

 

 

The Pause Screen is accessed by pressing the pause button while to cutter is cutting. From the Pause 

Screen you can enter the Setup Screen to change the main settings of the cutter, cancel the current cut, or 

exit the pause screen and continue cutting. You can also move the loaded material forwards or backwards, though 

doing so after a cut has begun is not recommended.  

Setup: Enters the Setup Screen (page 9). Allows to you to change the cutters main settings. If a test cut is 

made from the Setup Screen the current cut will be canceled.  

Abort: Cancels the current cut and returns to the Function Select Screen (Page 8). When you cancel a cut 

from the cutter, you should also be sure to cancel the cut from the cutting software on your computer.  

 

  

Pause Button Exits the Pause Screen and resumes the current cut.   

Left/Right 
Arrow Buttons 

Selects between the „Setup‟ and „Abort‟ options. 

Enter Button Confirms the selection between „Setup‟ and „Abort‟ 

Up/Down 
Arrow Buttons 
 

Moves the loaded media forwards and backwards similar to the Up/Down arrow buttons 
on the Jog Screen (page 10). Moving the material after a cut has started is not recommended.  
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Setting up 

If you are setting up for the first time please take a moment to refer to the Packaging Guide to take account off all the 

included components and accessories.  

For help with Stand Assembly, please refer to the included instructions.  

Selecting a Location for the Cutter 

The first step to setting up your cutter is finding a good location for the machine.  Consider these factors 

when you are selecting a suitable place: 

You will need to have access to both the front and rear of the machine for operations as well as for 

loading and unloading new vinyl rolls. Try to find a space with adequate access to both the front 

and back of the machine.  

Since your cutter is a precision cutting device, you will want to find a location that will be stable to 

insure cutting accuracy. Whether placing the unit on the stand, a floor or a table top, the accuracy 

of the machine will be directly related to the stability of the platform it is placed on. Find a sturdy 

floor space or table top for the machine and consider a location that will be out of the way of 

people and other machines with moving parts while the cutter will be operating.  Excessive moving 

of the machine can not only disrupt accuracy of cutting but may also cause electrical components 

inside the machine to dislodge and require otherwise unnecessary repairs and maintenance. 

Fans located inside of the cutter can draw in outside dust from the area surrounding the cutter. 

Excessive buildup of dust can cause either mechanical or electronic malfunctions. Keeping the 

cutter as dust free as possible will help ensure trouble free operation. Try to find an area for the  

cutter that will be free of any excessive dust and use the supplied cover when not in use.  

All cutters will produce a small amount of noise while operating. Please take this into consideration 

when selecting a location for your cutting purposes.  

Do not remove the grounding plug from the power cord or attempt to use the cutter when it has 

not been properly grounded. 

Use all available wheel brakes on the cutter stand to reduce movement during cutting.  

Keep the cutter away from liquids, heat sources and strong magnets.   

 

Connecting the Cutter to a Computer 

Attach the power cord to the cutter and then plug in the unit and turn on the power. 

If Using the a Serial or Parallel Cable  to connect your cutter to a Computer: 
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If you are using a Serial or Parallel Cable to connect your cutter to a computer then no further setup is 

necessary. Simply connect one end of the cable to the cutter and the other end to a computer and setup is 

complete. If you have more than one serial/parallel connection on your computer or you are experiencing 

communication issues between your cutter and computer then you may wish to verify that the correct port is being used 

in your software setup (see Finding Your COM/LPT Port on the next page), but for most users the port will be 1(i.e. 

COM1/LPT1).  

If Using the USB Cable to connect your cutter to a Computer: 

You will need to install drivers for the USB connection to work properly. These drivers can either be 

obtained from the supplied drivers disc or downloaded from the support website (in the downloads section of 

support.uscutter.com).Mac Users will need to download drivers from the support website as the drivers included on the 

disc are Windows only.  

Windows XP Users: 
1. Insert the driver disc or download (and unzip if necessary) drivers to your system.  
2. Connect the USB Cable to your computer and your cutter. The Found New Hardware wizard will 

appear. 
3. When asked, “Can Windows connect to Windows Update to search for software?” select “No, not 

this time” and click next. 
4. When asked, “What do you want the wizard to do?” select “Install from a list or specific location 

(Advanced)” and click next. 
5. Choose the “Search for the best driver in these locations” radio button and check the “Include this 

location in the search” checkbox. Now type  (or browse to find) the location of the downloaded 
drivers/inserted drivers disc and click next.  

6.  When the wizard is complete, click the Finish button. 
7. The Found New Hardware wizard should appear again. When it does, follow steps 3-6 again for 

the second driver.  

Windows Vista Users: 
If you want to use downloaded drivers, download them before starting the install process. 

1. Connect the USB Cable to your computer and your cutter. The Found New Hardware wizard will 
appear. 

2. When told that “Windows needs to install driver software…” select “Locate and install driver 
software (recommended)”. 

3. If Windows finds and downloads your needed drivers then the process is complete. Repeat the 
previous steps again for the second needed driver. If Windows does not find and download the 
needed drivers proceed to the next step. 

4. If you are going to install the drivers from the disc insert it when advised by Windows. If you are 
going to use downloaded drivers, select “I don‟t have the disc. Show me other options.” 

5. Browse to the folder where the drivers are stored and click next.  
6. When the wizard is complete, click the close button. 
7. The Found New Hardware wizard should appear again. When it does, follow steps 2-6 again for 

the second driver. 
 

If you are using another version of Windows or a Mac OS and require specific instructions for installing the drivers, they 

can be found at:  ftdichip.com/Documents/InstallGuides.htm. 
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Once your drivers are installed you will need to make a note of the COM port that has been assigned to 

your USB Cable connection.   

-Finding Your COM/LPT Port 

First navigate to the Device Manager by following the below instructions for your operating 

system: 

Windows 95/98/Me Users: 

Click Start, then select Settings -> Control Panel. 

Select Device Manager. 

 

Windows 2000/XP Users: 

Click Start, Then Right-click “My Computer” then select Properties. 

Select the Hardware tab. 

Click the Device Manager button. 

Windows Vista/7 Users: 

Click Start, Then in the "Start Search" box, Type "Dev" (without pressing enter); wait for a 

list to show up. 

Click Device Manager. 

Expand the section labeled “Ports (COM & LPT)”. 

Make a note of which number COM/LPT Port is associated with your cutter. 

You will need this information to properly install your software. 

Installing SignBlazer Software 

Insert the SignBlazer Elements CD into your computer. 

Select “Run Setup” . 

Follow the on screen instructions. 

Ignore the warning of only being able to install SignBlazer on one computer. This does not apply since you 

will be using trial mode and updates are no longer available for the SignBlazer software.  

When asked what cutter you want to use, select the model that matches your Copam cutter (2500, 4050 

or 4500). 

When asked if you want to install the USB driver, select “No” since we have already done so.  
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When asked what port your cutter uses, select the Port that corresponds with your setup. If using a USB  

connection you will need to select the COM port that corresponds with your setup (Noted above from the 

“Finding Your COM Port” section of the manual). 

Make sure that your Baud Rate option is set to 9600. 

Do not change the, Data Bits, Stop Bits, or Parity options. 

Make sure the Flow Control option is set to “Hardware”.  

Installing SignCut (and Inkscape*) Software 

*If you will be using the SignCut software to cut from your computer you will also need a vector design program. 

SignCut is strictly a cutter interface and cannot be used to create signs and designs. The instructions in this manual will 

give directions for using Inkscape (A popular free vector design program) with SignCut but directions for other software 

will be mostly the same. If you prefer creating vector graphics in Illustrator, CorelDraw, or another vector graphic 

design program then you can choose to not install Inkscape and work with your preferred software.  

Go to: www.signcutpro.com/bundle.html 

Fill out the form and click “Register” 

You will be directed to a page where you will be given a download link and a license number. Save this 

page or print it for reference. A copy of this page will also be sent to the email address used while filling 

out the Registration form.  

Follow the link to the web address that corresponds to your operating system and download the SignCut 

software installation program.  

After the SignCut software installation program has been downloaded, run the program and follow the on 

screen instructions.  

You will be asked if you would also like to download Inkscape. If you have not already done so and you 

would like to use the Inkscape software as a vector design program, select the yes button and the Inkscape 

software will be downloaded. 

Follow the Inkscape installation instructions. SignCut installation will be temporarily paused.  

When you are finished installing Inkscape SignCut will resume installation and finish.  

Installation is now complete.  
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Installing a New Blade 

Unscrew the 
cap from the 
Blade 
carriage. 
 

Set Brass Ring 
on Blade 
Carriage to the 
fully down 
position 

Remove the 
protective 
cover from 
a new 
blade. 
 

Insert the 
blade into 
the top of 
the Blade 
carriage. 
 

Screw the 
cap back 
onto the 
blade 
carriage. 
 

Adjust the 
carriage cap 
until the blade 
is protruding 
approximately 
1/64th of an 
inch.* 
 

Adjust the 
Brass Ring 
until it fits 
snug against 
the Cap. This 
will help keep 
the cap in 
place during 
operation. 

 
 

    
 

*This distance will vary depending on what material you are cutting. Your blade depth should be adjusted 

to approximately; 

 The height of your cuttable material + ½ of the height of the backing material.  

 

 

 

 

 

 

 

 

 

This will allow the blade to fully cut the material without fully penetrating the backing. 1/64th of an inch is 

a general guide that will work well with many common vinyl products and is a good starting point for determining the 

blade depth for your material, but some adjustments/fine tuning to blade depth will be necessary in most cases.  
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Replacing a Worn Blade 

First remove the blade carriage from the carriage arm, 

Unscrew the cap of 
the blade carriage 
 

Carefully pinch the 
blade on both sides 
and pull it up and out 
of the Blade 
Carriage. 
 

  
 

Follow the steps from “Installing a New Blade” on the previous page. 

  

Loosen the locking knob on the 
carriage arm.  

Place Blade carriage into the 
carriage arm. 

Tighten the locking knob on the 
carriage arm.  
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Installing a Pen Carriage (Optional) 

Many new users will benefit from practice “cutting” with the optional pen carriage until they are comfortable with 

normal operations of the cutter and cutting software.  

 

Your Pen Carriage should come assembled and appear as it does in this image. If it does not, please refer to the pen 

replacement section below for assembly instructions. 

To install the pen carriage: 

 

To Replace the pen or spring inside of the Pen Carriage: 

Unscrew the top cap from the Pen carriage. 

 

Loosen the locking knob on 
the carriage arm.  
 

Drop the pen attachment into 
place in the front slot of the 
carriage arm. 

Tighten the locking knob on 
the carriage arm. 
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Remove the top cap, the pen and the spring. Replace the pen and/or spring as necessary. Slide the spring 

onto the pen from the top and insert it back into the pen carriage.  

 

Replace the carriage cap and screw into place. 

 

 

 

 

Once you are familiar with the cutter and its basic functions, install the blade carriage (next). 
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Preparing for Cutting 

If you are going to cut from a scrap or single sheet instead of a roll, then skip the next step on placing a roll. All other 

steps will be the same. 

Place the roll of media on top of the stand rollers. 

 Release the Pinch Rollers by pulling up on the Pinch Roller Release Levers. 
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Feed the media through the back of the machine, underneath the pinch rollers (if working from a single sheet 

instead of a roll, the material can also be fed from the front). 

 

Adjust the pinch rollers so there is one roller located on each side of the material (and, on models with 3 or 

more rollers, one roller near the center). Only lower the pinch rollers where there is a feed roller below. Use 

the Feed Roller Guides (page 4) to determine placement of feed rollers.   
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Leave a gap of between ½”-1 ½” from the edge of the roller and the edge of the material on both sides. 

Make sure that the pinch rollers are only lowered where there is a Feed Roller below. The front of the 

pinch roller should always be placed along a Feed Roller Guide to made sure that there is a Feed Roller 

below.  

 

Engage the Pinch Rollers by pushing down on the Pinch Roller Release Levers. 

 

If the cutter is not already on, turn it on and select your media type („Scroll‟ or „Sheet‟) from the Measure Screen to find 

the cuttable area of your material.  

If the cutter is already on go to the Measure Screen and select your media type („Scroll‟ or „Sheet‟) from the Measure 

Screen to find the cuttable area of your material.  
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If you would like to change the position of where the cut will be made: 

Enter the Jog Screen of the cutter (directions for changing menu screens are located in the Control Panel section of 

the manual starting on page 7).  

Adjust the vinyl to where you want the cut to start by using the Up and Down Arrow Keys on the Control 

Panel. 

 

 
 

 

Now, adjust the Blade to where you want the cut to start by using the Left and Right Arrow Keys. 
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Now hold the Enter button until the origin of the cutter is set. This is the location where the next cut will 

begin. 

When choosing a starting location on your cutter, remember that the process will start in the bottom right area of the 

design. Please leave enough room to the left of and above the starting location to finish your cut.   

If you would like to make other adjustments to the pressure, speed, or other settings you can do so now. If you are setting 

up for your first cut with the machine then the default values should be a good starting point. 
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Step By Step Instructions 

Starting SignBlazer for the First Time 

Open the SignBlazer Software (The Default location will be in the Programs Folder under “SignBlazer Elements for 

USCutter”). 

 

Navigate to this folder and select “SignBlazer Elements for USCutter”. 

SignBlazer will attempt to download update files. 
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When it fails, cancel the update process (By Pressing the Cancel button on the error window and then OK on the 

confirmation window) and the program will start regularly. To override the update process in the future, 

refer to the Troubleshooting listing titled “When starting the SignBlazer Software it fails to find updates”, 

located in the Troubleshooting section of the manual (starting on page 48).  

 

 

 

We will be working in Trial Mode. Select “Trial Mode” from the following screen, then select “Yes” from 

the confirmation window. 
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Now SignBlazer is open and you are looking at the main SignBlazer screen. 

 

Making a Simple Cut in SignBlazer 

You can create images from scratch using the various tools in SignBlazer. For this tutorial, we will be 

drawing a simple square just to show the steps of making a cut from SignBlazer. 

 

Select the Square tool at the top of the window. 
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Now draw a square by clicking first in the main 
window… 
 

And then moving the mouse to determine the size 
of the square desired, and clicking a second time. 
 

  
 

Now to cut this simple shape from the cutter: 

Select Cutter from the top selection menu. 

 

This will take you to the cutter screen of SignBlazer Elements where you can see a representation of how 

your cut will be made when sent to the cutter as well as various cutter options. 
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Since this is a simple cut, no adjustments need to be made here. We can tell the software we are ready to 

cut by pressing the cut button in the top selection menu… 

 

and then pressing “Cut Tile” in the Cut Tile window: 

 

When you are finished, you can go back to the main SignBlazer screen by pressing the Finish button in the 

top selection menu. 

 

Importing in SignBlazer 

Drawing images from scratch in SignBlazer may prove to be somewhat different than imaging software that 

you are more familiar with. If you would rather create the images to be cut in another software or you 

already have designs finished that need to be cut, then you can just import the finished artwork into 

SignBlazer and cut from there.  

Most major raster and vector image files are supported in SignBlazer Elements including dxf, eps, ai, bmp, tif, gif, pcx, 

tga, jpg, pcd, pct, psd, cmx, ps, and wmf. 
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You can import to SignBlazer one of two ways: 

Using the Clipboard 

You can import from the clipboard by first copying or cutting an image opened from another software 

program, and then placing it into SignBlazer by selecting Clipboard Paste from the Edit drop down menu. 

Images imported via Clipboard Paste may not retain the same dimensions that they held in another software 

program. 

Using the Import Function 

You can import an image that has been saved from another program by first selecting Import from 

the File drop down menu: 

 

Then navigate to the saved file by using the Folder and Drives menus: 
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Then Select the image to import, 

 

And select the OK button. 

 

 

 

If you are having trouble locating your file, make sure that the file type is selected from the “List Files of Type” 

menu, or that  “All Graphic Files” is selected. 

 

 

If the file imported is already a vector image then it is now ready to cut or be further edited within 

SignBlazer. If you are ready to cut, you can follow the steps in the previous section “Making a Simple Cut 

in SignBlazer”(starting on page 27).  

If the image imported is a raster image then follow the steps in the next section “Converting a Raster 

Image to Vector in SignBlazer” to further prepare the image for cutting. 
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Converting a Raster Image to Vector Image in SignBlazer 

The difficulty of converting a raster image to a vector image will vary greatly depending on the amount of contrast in 

the image. The portion of the image to be cut should be darker than the background or surrounding area and should 

have a significant amount of contrast and separation from the rest of the image. If possible, the image should be 

completely separated from the background and be black in color (though the image we chose for this demonstration has a 

background and is not completely darkened to demonstrate that the process is possible with a variety of images). 

First make sure that the image has been properly imported into SignBlazer and that the image is selected.  

You can tell an image is selected when it shows a border and square bounding boxes around its parameter. 

 

With the image selected, select “Monochrome – 1 bit” from the Mode section of the Image drop down 

menu. 

 

Sometimes an imported image will already be in monochrome but will still need to be vectorized before being cut. If the 

image imported is monochrome than you can skip this step. 
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The “Convert Image to monochrome” window will appear.  

 

 

Now you can adjust the Threshold Level slider. Where you place the slider will determine how much of 

the image will be included in the monochrome conversion (which is to become the image that will be cut). 

Anything darker than the level set on the Threshold slider will be included in the cut and anything lighter 

will not.  

Since we chose an image with good contrast and separation for our example this process will be easy. We 

simply check that our image to be cut shows up in light grey or black and that there are no areas of the 

background or other parts of the image that are unnecessarily included.  

 

Now press the OK button on the “Convert Image to monochrome” window. 

Now to convert a monochrome image to a vector, select “Vectorise” from the Image drop down menu. 
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And press the OK button on the Vectorise Image window. 

 

You are now left with 1 monochrome image and 1 vectorized image. This may be difficult to see as they 

are probably layered directly on top of one another. If you grab one image and drag it you will see the 

other image left behind. You can now delete the monochrome image that has been left behind as it is no 

longer needed. 

 

The cutting process for a vectorized image is the same as it is for cutting a simple image. You can now 

follow the steps from the “Making a Simple cut in SignBlazer” section of this manual (starting on page 27) to 

make your cut. 
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Starting SignCut and Inkscape for the First Time 

Open the SignCut software (The Default location will be in the Programs Folder under “SignCut Productivity Pro”). 

Navigate to this folder and select “SignCut”. 

 

 

The first time that you run SignCut you will be prompted with a Setup Wizard.  

 

 

 

 

 

 

 

Follow the onscreen instructions, entering your License number that you received when you registered 

and downloaded SignCut. 
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Then Select your Manufacturer, Cutter model and Connection method.  

 

 

 

 

 

 

 

Setup will then be completed and you will be taken to the main SignCut screen.  

 

 

 

 

 

 

 

We can now let SignCut run in the background while we do our design work in Inkscape (or another 

preferred vector image software). We will return to SignCut once we are ready to cut.  

To open Inkscape, simple locate the icon in your programs menu and open the program. No further setup 

will be required.  
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Creating a Simple Design in Inkscape  

You can create images from scratch using the various tools in Inkscape and then cut them from SignCut. 

For this tutorial, we will be drawing a simple square just to show the steps of sending files from Inkscape 

to SignCut and then making a cut. 

Select the Square tool from the left of the main Inkscape window. 

 

 

 

 

 

Now draw a rectangle by clicking and dragging the mouse in the main window, then releasing when the 

desired size is met. 

  

 

 

 

 

 

 

Now, click on the Fill and Stroke button at the top of the screen to edit the shape. 

 

 

 

 

In the Fill and Stroke panel we will edit the colors of the shape to make it more identifiable once we get to 

the SignCut program.  

To edit the Fill and Stroke properties of the rectangle make sure that it is selected. If you haven‟t made any other shapes 

or made any other changes in Inkscape it should still be selected. If it is selected you should see a dotted border 
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surrounding the shape with a square symbol in two of the corners and a circle in another like the image below. If the 

shape is not selected, make sure you are still using the square tool and click on the shape to select it.  

 

 

 

 

 

Select the Fill tab from the Fill and Stroke panel.  Then select “Flat color” from the options at the top of 

the panel. 

  

 

 

 

 

 

 

 

Use the R, G, and B sliders from under the RGB tab to select a color for the object. This is the color the 

object will appear in SignCut. Here we have chosen a dark red with values of R(68), G(24), and B(24).  

 

Make sure the alpha slider (A) is set to 255. 
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Now from the Stroke Paint tab select “No Paint”. 

  

 

 

 

 

 

 

 

The object is now ready to be saved so that it can be opened and cut from SignCut.  

Select File>Save As from the top menu. 

  

 

 

 

 

Select a name and location for your file (Here we have chosen the name “rectangle” and are going to save to our 

desktop).  
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Then select “Encapsulated Postscript (*.eps)” from the drop down menu at the bottom of the window. 

 

 

 

 

 

 

For a simple design you will most likely not need to check any of the boxes in the Encapsulated Postscript 

window. Uncheck all boxes and select “Ok”. 

  

 

 

 

In the next section, “Cutting a Simple Design in SignCut”  we can open our file and send it to the cutter to 

be cut.  
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Cutting a Simple Design in SignCut 

In SignCut Select File>Open.  

 

 

 

Locate your file in the window and select “Open”.  

 

 

 

 

 

 

 

You will see the shape that you created in the main window of SignCut.  

 

 

 

 

 

 

Please make sure that your cutter is on and ready to cut before proceeding. See the “Preparing for Cutting” 

section of the manual (page 20). 
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Select the color that you would like to cut from the color selections on the right.  

 

 

 

 

 

If you are following from the previous section, “Creating a Simple Design in Inkscape” you should have only one color. If 

you are working from another file you could have many different colors.  

Since we are making a simple cut, no other settings or options need to be adjusted here. We can simply 

click on the “Cut Out” button from the left menu to open the Cut Out window.  

 

 

 

 

 

Then press the Cut Out button from the Cut Out window to make your cut.  

 

 

 

 

 

 

 

 

 

If your design has multiple colors, replace the vinyl in your cutter with the color you wish to cut, select that color from 

the color selections on the right and repeat for each color.  
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Converting a Raster Image to Vector Image in Inkscape 

If you already have designs finished that need to be cut and are in a vector format, such as .ai, .eps, .svg etc. you can 

cut them by following the instructions in the previous section, “Cutting a Simple Design in SignCut”. If they are in a 

raster image format then they can be converted to vector for cutting depending on their level of detail.  

The difficulty of converting a raster image to a vector image will vary greatly depending on the amount of contrast in 

the image. The portion of the image to be cut should be darker than the background or surrounding area and should 

have a significant amount of contrast and separation from the rest of the image. If possible, the image should be 

completely separated from the background and be black in color (though the image we chose for this demonstration has a 

background and is not completely darkened to demonstrate that the process is possible with a variety of images). 

From Inkscape open the file by selecting File>Open from the top menu and then locate your image and 

press the Open button. 

  

 

 

 

 

Most major file formats can be opened in Inkscape including .jpg, .gif, .tif, .png, .ico, etc. 

Select the image by choosing the selection tool. 
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Then click on the image.  

 

 

 

 

You can tell an image is selected when it shows a dotted  border and multiple sets of arrows surrounding its parameter. 

With the image selected, select Path>Trace Bitmap from the top menu.  

 

 

 

The “Trace Bitmap” window will appear.  

 

 

 

 

 

 

 

Make sure the Brightness cutoff radio button is selected.  

Now you can adjust the Threshold level by inputting a number between 0.000 and 1.000 in the Threshold 

box (adjacent from the Brightness cutoff button). The number you select will determine how much of the 

image will be included in the vector conversion (which is to become the image that will be cut). Anything 

darker than the level set on the Threshold slider will be included in the cut and anything lighter will not.  

Since we chose an image with good contrast and separation for our example this process will be easy. We 

will set the Threshold level to .500 and click the Ok button. If you are unsure where to set your Threshold 

amount then you can try different values and then use the Update button at the bottom of the preview panel to generate 

a preview.  
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Then close the Trace Bitmap window by pressing the close button on the top right of the window. If you 

are unsure what amount to use you can try a variety of numbers and preview how the vector image will look by pressing 

the Update button below the Preview window.  

There are many different ways to get a vector image from a raster image. We have chosen to show one of the more 

common and simpler variations. Some images will not be easily converted directly from raster image to vector or will 

require extra editing during the conversion process. 

You are now left with 1 rasterized image and 1 vectorized image. This may be difficult to see as they are 

layered directly on top of one another. If you grab one image and drag it you will see the other image left 

behind. 

  

 

 

 

You should now delete the rasterized image that has been left behind as it is no longer needed and could 

cause problems when you try to open the file in SignCut.  

Select the rasterized (original) image. 

  

 

 

Then select Edit>Delete from the top menu to delete it. 
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The object is now ready to be saved so that it can be opened and cut from SignCut.  

Select File>Save As from the top menu. 

  

 

 

 

Select a name and location for your file (Here we have chosen the name “USC_logo” and are going to save to our 

desktop).  

  

 

 

 

Then select “Encapsulated Postscript (*.eps)” from the drop down menu at the bottom of the window. 

 

 

 

 

 

 

For a simple design you will most likely not need to check any of the boxes in the Encapsulated Postscript 

window. Uncheck all boxes and select “Ok”. 

  

 

 

 

Now that the image is vectorized and saved, the cutting process is the same as it is for cutting a simple 

image. You can now follow the steps from the “Cutting a Simple Design in SignCut” section of this manual 

(starting on page 41) to make your cut. 
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Specifications 

Maximum Paper Feed Width CP-2500(24 inch model) - 24 inches (610mm)  
CP-3050(35 inch model) - 36 inches (915mm)  
CP-4050(48 inch model) - 48 inches (1220mm)  
CP-4500(54 inch model) - 54 inches (1370mm)  

Maximum Cutting Width CP-2500(24 inch model) - 23.2 inches (592mm)  
CP-3050(35 inch model) - 35 inches (890mm)  
CP-4050(48 inch model) - 46.9 inches (1190mm)  
CP-4500(54 inch model) - 53.2 inches (1350mm) 

Cutting Speed 4-24 Inches per second (100-600 mm per second) In 4 inch per 
second (100mm per second) increments 

Pressure Range  50-500g  In 10g increments  

Maximum Cutting Thickness .04 inches (.8mm)  

Coordinate Origin Coordinate origin specifiable 

Number of Cutter/Pen 1 

Standard of Blade and Holder F2 

Material Calendared self-adhesive vinyl film, fluorescent film, reflective 
film, paper card or other materials of thickness between 0.05-
0.30mm 

Maximum Velocity 0.025mm/Step 

Programmable Resolution 0.05mm/Step 

Distance Accuracy Within 0.15% of distance moved 

Repeatability Within 0.02mm 

Command Sets Compatible with HP-GL 

Interface Centronics parallel/RS-232 serial(auto interface recognition) 

Processor/Memory Adapt 16 bits DSP technology, 64Mb Memory 

Drive Divisional motor 

Lifting and Dropping Rate 15times/sec 

Acceleration 4g 

Power/Consumption 110v/250v 50-60HZ. 120W(max) 

Customer Service/Technical 
Support Line 

425-481-3555; Available 7am - 5pm, Mon-Fri   

Online Technical Support support.uscutter.com 
E-mail: support@USCutter.com 

Customer Forums forum.uscutter.com 

Manufactured For and Sold 
Directly By 

 
19510 114th Avenue NE, Suite C-1 
Woodinville, WA 98072 
425-481-3555 phone 
888-640-0720 fax 
www.USCutter.com 
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Troubleshooting 

Problem Solution 

The cutter is unresponsive to 
communications from the 
computer and software. 

Communication issues can arise if the cutter was powered on while 
the software is trying to send data to the cutter. This is most 
common when using SignBlazer software. Exiting the cutter screen 
of SignBlazer and returning to the main SignBlazer screen may 
resolve this issue. If not, save all work and try exiting SignBlazer 
and restarting with the cutter powered on. It is good practice to 
start SignBlazer with the cutter powered on to avoid 
communication problems. 

 
Make sure that your output device setting on your software is set 
to the correct COM/LPT port (Found by selecting File>Cutter from 
the menu on the main SignBlazer screen, and then selecting Setup from the 
top menu buttons or by selecting Settings>Cutter in SignCut). Your port 
can be found by following the instructions in the “Finding Your COM.LPT 
Port” section of this manual on page 14. You can change your COM 
Port by right-clicking on the COM Port in the device manager and 
going to the advanced section of the Port Settings tab. 

 
Adjust your Flow Control settings to Hardware by first locating 
your COM/LPT Port in the device manager (By following the 
instructions on page 14), then right-click the Port and select 
Properties. On the Port Settings tab, change to Flow Control 
option to Hardware. 

 
 Try a different connection method between your cutter and 
computer. If another connection method is not available, try a 
different cable (serial, parallel, USB) to connect from the cutter to 
computer. Also try the current cable on another device to test if 
the problem is from the cable. Replace if necessary. 

The cutter performs erratically 
during cuts, stops cutting 
before the cut is finished, or 
cuts lines that do not appear in 
the design. 

Some computers do not work well when connected via the USB 
port of the cutters. If you are having problems while cutting and 
are using the USB cable to connect from your cutter to computer, 
you may wish to try the serial cable connection to avoid further 
problems. If a serial cable connection is not available on your 
computer, you can try a third party USB to serial connecter or a 
PCI card serial adapter for your computer.  
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When starting the SignBlazer 
Software it fails to find 
updates. 

This is a regular occurrence of the SignBlazer software and should 
not be considered a problem. All features of the software will 
continue to work in trial mode without updates.  
To deactivate the update process, redirect the SignBlazer shortcut 
(of either the desktop icon or start menu selection that you use to open the 
SignBlazer software). Right-click it and select Properties. From the 
Properties menu, change last section of the Target option from 
“sb.exe” to “sbnt.exe”. Press the Apply button, then the OK 
button. This will bypass the update process. 

Cuts are jagged or inconsistent. The Blade may be dulled or damaged. Replace with a new blade 
and try again. Make sure that the blade can turn freely by 
attempting to turn it with your fingers while it is set in the Blade 
Carriage. 

 
Adjust the blade depth of the Blade Carriage (page 16) and Force 
setting on the cutter (page 9)  until you are getting solid, uniform 
cuts. Follow the instructions on page 16 to set the blade depth and 
then adjust the Force setting of the cutter until the problem has 
been corrected. 

Slashes are made across the 
vinyl from the blade movement 
during cutting 

If the blade is protruding too far from the Blade Carriage then it 
can score and cut material during normal operations. If this is 
occurring, the blade needs to be adjusted so that it is protruding a 
minimal distance from the carriage. See the instructions on page 16. 

Plotter does not power on Check if the power cable is securely connected to the cutter and a 
grounded power outlet/surge protector. If the connection is 
secure and there is still no power than the power cord could be 
damaged. Try another power cord with your cutter or try the 
power cord from the cutter on a different device to test if the 
problem is from the power cord. Replace if necessary.  

The measurements of the media 
are inconsistent/incorrect.  

The cutter uses light sensitive sensors to detect where your 
cuttable media is placed. If the cutter is placed near a strong light 
source, the sensors can act erratically. Try to redirect any strong 
light sources that are close to, or pointed towards, the cutter.  

 
The width measurement is made from the distance of the two 
outer pinch rollers. If you are getting an unusually inaccurate width 
measurement, make sure that the 2 outer pinch rollers are set on 
the edges of opposite sides of the material (page 21) 

Other troubleshooting solutions may be found by visiting the Customer Forums or Technical Support Website, or by 

calling the Technical Support Line (Web page addresses and Phone number on the specifications page, 47). 


